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About this Release

This document lists new features, known issues, and potential incompatibilities as of the release date. If you discover an

issue, please review the Known Issues list below to determine if it has already been documented. If the issue is not
referenced, please visit Browsium Support for troubleshooting tips, product documentation, and the option to submit

support tickets.

What is Catalyst

Browsium Catalyst is a multi-browser web traffic manager for the enterprise, enabling IT to pair all web applications with

the most compatible and secure browser on every PC in the organization.

What's New in this Release

This section of the release notes is reserved for notable changes and new features since the prior version.

What's new in Catalyst 4.0
This section details changes to Catalyst since the prior version, Catalyst 3.2.

e The new, unified Browsium Client includes the agent functionality for Proton, lon, and Catalyst, resulting in a
simple client deployment that works with all modules in the Browsium browser management suite.

o Browsium Client includes browser extensions for Internet Explorer, Chrome, and Firefox.

o Browsium Client installs a new Browsium Service (BrowsiumService.exe) to handle client operations that require
administrative privileges at runtime.

o Browsium Controller (BrowsiumController.exe) and Browsium Monitor (BrowsiumMonitor.exe) replace Browsium
Catalyst Controller (BrowsiumCatalystController.exe) and Browsium Catalyst Monitor (BrowsiumCatalystMonitor.exe) from
prior versions. These new processes provide functionality for lon, Catalyst, and Proton if configured, reducing
the overall memory footprint and number of processes required to run the Browsium suite.

e Adds support for ‘Starts With' rule matching to provide more granular targeting of websites that require browser
redirection.

e Adds support for Enhanced Protected Mode in Internet Explorer. The Browsium Client Extension for Internet
Explorer is now 64-bit compatible, so Catalyst can run in 64-bit Internet Explorer tab processes.
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Minimum System Requirements

Operating System Windows XP *

Windows 7

Windows 8

Windows 10

Windows Server 2003 *
Windows Server 2008 R2
Windows Server 2012 R2

Browsers Microsoft Internet Explorer 8, 9, 10, or 11
Google Chrome 39 or later
Mozilla Firefox 35 or later

.NET Framework Version 3.5 SP1 or later (full version only)

Processor 1 GHz 32-bit (x86) or 64-bit (x64) processor

Memory 1GB total system RAM; 2GB for multi-user servers

* Browsium Client is supported on Windows XP and Windows Server 2003. Catalyst Configuration Manager requires Windows 7 or later.

Installing and Using This Release

e You must install both Browsium Client (Browsium-ClientSetup.exe) and Catalyst Configuration Manager (Catalyst-
Setup.exe) to develop Catalyst projects. End user PCs require only Browsium Client.

e Browsium Client 4.0 installer will automatically close all browser windows. Enterprise deployments to end user PCs
should be scripted to install at night or immediately following a reboot.

e Catalyst 4.0 cannot read projects created with Catalyst 1.x or 2.x. These projects must be recreated from scratch
using Catalyst Configuration Manager. Catalyst 4.0 will read projects created with Catalyst 3.0.x. Catalyst
Configuration Manager will upgrade these projects to the Catalyst 4.0 format.

e It's a good practice to close browser windows, and associated processes, before installing the Browsium Client. If
browser windows are open, the Browsium Client installer will close the windows and processes automatically,
which may result in a warning message the next time the browser is launched. This warning message can be
ignored.

e Install Browsium Client in the 30-day evaluation mode by leaving the Catalyst License Key field blank on the
“Client Configuration” screen during setup, unless Browsium has already provided you with a Catalyst license key.

e Catalyst Configuration Manager 4.0 cannot be installed if lon Configuration Manager 3.x is already installed on the
system. You must first uninstall lon Configuration Manager 3.x. Upgrading Catalyst Configuration Manager 3.x to
4.0 is supported if lon Configuration Manager 3.x is not present on the system.

e If using Catalyst on Windows 8 or Windows 10, you will need to manually set Catalyst as the default browser in the
Default Programs control panel or when prompted. For enterprise deployment, it's recommended that you control
this setting via Group Policy.

e Read the Catalyst Administration Guide for more information on installing and using Browsium Catalyst.
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Known Issues

e On Windows 7 and later, links and web documents on the file system use a custom icon provided by Catalyst. On
Windows XP, they use the icon of the last default browser before Catalyst was installed.

e Catalyst silently ignores the rules that have same Starting Browser and Target Browser value, regardless of other
options selected for the rule.
e Catalyst is disabled by default for Internet Explorer’s InPrivate mode and Chrome's Incognito mode. Catalyst can

be enabled manually for these modes.

e The command to auto-enable the Catalyst Firefox extension, as documented in the Catalyst Admin Guide, may fail
if multiple Firefox profiles are present on the system.

e When Project->Project Settings->Override Default Browser is enabled, the default browser may show a warning
that it is not the default browser on the system. For Catalyst to be able to evaluate rules from non-browser
applications, please select “Don’t ask again” option in Internet Explorer, Firefox and Chrome browsers. These
settings can be managed by Group Policy in an enterprise deployment.

e When Project-> Project Settings-> Override Default Browser is disabled, Internet shortcuts may fail to comply with
Catalyst rules if the default browser defined in Windows Default Programs is not already running when the link is
clicked. To avoid this issue, it is recommended that you set Override Default Browser to Enabled, and manage the
default browser setting via the Catalyst configuration.

e Catalyst cannot execute a rule against the homepage for Chrome or Firefox. The homepages will load regardless
of Catalyst settings.

e Setting a rule to open google.com in Internet Explorer can cause unpredictable behavior when using the New Tab
button or searching via Chrome's address bar. The New Tab page and address bar searches in Chrome include
references to google.com that can trigger redirection to Internet Explorer. To avoid this issue, always use Chrome
for Google sites if using Chrome for any sites, or create a rule with Target Browser = Any for google.com.

e (Catalyst does not support Custom zones in Internet Explorer.

e When a browser has Block Other Requests enabled, it will not evaluate rules unless those rules have a Starting
Browser set to Any. A rule with the Starting Browser set to a specific browser and the Target Browser set to a
browser with Block Other Requests enabled may cause a looping condition and should be avoided.

e Catalyst Controller is not launched in developer mode when started (or restarted) from the Utilities menu within
Catalyst Configuration Manager. Therefore, neither Splash Screen nor the Windows 8+ (and Windows Server 2012)
default browser picker dialog will be shown when Controller is started. The Controller is started in developer mode
when choosing Start Test Configuration from the File menu.

e When redirecting between browsers via Catalyst rules, the Starting Browser may navigate to a blank page,
navigate back one page in the browser history, or close the tab entirely if the navigation crosses between Internet
Explorer zones. This is due to an issue with how Internet Explorer exposes its history to Browser Helper Objects.
This issue should not interfere with the proper function of any web applications.

Contact

For technical support, please visit the Browsium Support website.
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What's New in Prior Releases

What's new in Catalyst 3.2:
This section details changes to Catalyst since the prior version, Catalyst 3.1.2.

e New Project Update Activation feature improves configuration deployment by enabling on-the-fly and scheduled
configuration updates on clients without restarting the Catalyst Controller.

e Catalyst now supports rule evaluation within browsers that have been launched "as administrator"”.

e The default browser selected within Catalyst now handles invoking "Search Online" from within the Windows Task
Manager, and similar utilities. The search will be launched inside the default browser in the Catalyst configuration.

e Fixes a bug in Catalyst default browser handler to successfully launch Visual Studio web debugger.

e Fixes a bug that affects Regex rules with some special options.

e Fixes a bug in Catalyst Internet Explorer Add-on to avoid a navigation error that results in a blank page with the
URL http:/// on certain rule evaluations.

What's new in Catalyst 3.1.2:
This section details changes to Catalyst since the prior version, Catalyst 3.1.1.

e Includes a new Catalyst Extension for Firefox (version 3.2.0.58) which is signed by Mozilla and compatible with the
current Firefox release 44 (and later) which requires signed extensions.

e Fixes a crash in BrowsiumCatalystLauncher.exe when opening new links from third party applications.

e Fixes a crash in the Enable Firefox Extension registry action when there are empty Firefox profiles on the system.

What's new in Catalyst 3.1.1:
This section details changes to Catalyst since the prior version, Catalyst 3.1.

e Fixes a transport layer bug that caused the Catalyst Controller to hang when non ASCII characters are present in a
URL.

e Fixes a bug in the Catalyst Chrome extension when evaluating a rule on a URL that opens in a new window.

e Fixes a bug in the Catalyst Chrome extension when evaluating a zone rule.

What's new in Catalyst 3.1:
This section details changes to Catalyst since the prior version, Catalyst 3.0.1.

e Adds support for Windows 10 (IE11, Chrome, and Firefox only; Catalyst does not work with the Edge browser
which has no extension model).

e Fixes an issue in the Catalyst Chrome extension which causes the Chrome back button to loop between the
current and next most recent URL.

e Improves the experience in Chrome for websites with 302-redirected traffic.

e Fixes in issue which causes Catalyst to fail to run properly on the Turkish version of Windows.

What's new in Catalyst 3.0.1:

e Fixes an issue which causes Catalyst to fail to bring minimized browser windows into focus when executing a
browser redirection.

e Fixes an issue which causes Catalyst to fail to properly redirect links from within Microsoft Outlook.

e Improves “Same Page” starting action experience for Internet Explorer when the navigation causes a zone switch.

e Adds an advanced custom Catalyst preference that allows Catalyst to evaluate rules on 302 redirected traffic.

e Fixes an issue in rule evaluation when very long URLs are used.
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e Fixes a rare race condition in Catalyst controller that could cause it to stop evaluating rules.

What's new in Catalyst 3.0.0:

e New Catalyst Configuration Manager, based on lon Configuration Manager, delivering consistent experience,
improved speed, and enabling more rapid addition of new features.

e Copy/paste rules within and between projects for faster configuration development.

e Improved configuration testing functionality uses XML files instead of serialized registry entries, with automatic
saving of project files and simplified menu options — consistent with lon.

e Logging to Event Viewer for both Catalyst Configuration Manager and Catalyst Client.

e Renamed Catalyst Configuration Manager installer to Catalyst-ManagerSetup.msi (from Catalyst-AdminSetup.msi

in prior versions).
e Added Splash Screen that is displayed on Controller start, but defaults to ‘Disabled’ in Project Settings. Splash
Screen is always shown if Controller is started via Start Test Configuration.

e Simplified configuration hierarchy, based on XML-formatted project files, to ease deployment. (Note, Catalyst 3 is
not compatible with Catalyst 2 project files.)

¢ New ADM/ADMX templates for easy Group Policy deployment of configuration file pointers are available from the
Catalyst Knowledge Base.

e Updated the command-line switch that displays registry and file location of active Catalyst configuration, now via
the command "BrowsiumCatalystController /WhichConfig".

e Added a new capability to show WhichConfig results and .NET CLR version by pressing 'Ctrl" while displaying the
Catalyst Configuration Manager About Box.

e Improved robustness to handle scenarios where browser processes start before Catalyst Controller after PC reboot

e Configuration caching to enable offline Catalyst process initialization when deploying project file on a server.

e New configuration option to set Target Browser = Any, allowing specific sites to open in any browser, even when
Block Other Requests is enabled.

e Support for defining Chrome Application Mode (Chrome with no menus or address bar) as a custom browser, with
rule evaluation to and from Chrome Application Mode.

¢ New asynchronous Chrome extension runs as standalone Windows process for greater robustness.

e Support for high DPI monitors enables project development at any screen resolution.

e Catalyst process names have been updated to be more consistent and more easily identified:
Prior > Current
ManagerUl.exe - BrowsiumCatalystManager.exe
Controller.exe - BrowsiumCatalystController.exe
CatalystMonitor.exe = BrowsiumCatalystMonitor.exe

What's new in Catalyst 2.0.2:

e Fixes an issue that blocked Catalyst Controller from starting when no network connection is available.

What's new in Catalyst 2.0.1:

e Improves Chrome window focus after redirection from Internet Explorer to Chrome.
e Fixes an issue that blocked Catalyst Controller from starting on non-English versions of Windows XP.
e Support for alpha-numeric license keys.

What's new in Catalyst 2.0:

e Support for Windows 8.1 with IE11, and IE11 on Windows 7.
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e Support for bi-directional redirection of URLs between native Internet Explorer, Chrome, and Firefox and virtual IE
using Citrix XenApp.

e Support for bi-directional redirection of URLs between native Internet Explorer, Chrome and Firefox and virtual IE
using VMware ThinApp.

e New command-line switch displays active Catalyst configuration via the command “Controller /WhichConfig".

e Integrated setup allows choice of license key or 30-day evaluation during installation of Catalyst Client.

e Fixes an issue where custom browser paths did not automatically insert a trailing slash when exporting projects to
ADM or ADMKX files.

e Fixes an issue where navigation between zones caused a blank page or redirection message in Internet Explorer
when the desired Starting Browser action is Same Page.

What's new in Catalyst 1.0.3:

¢ Windows Server 2003 and Windows Server 2008 are now supported operating system platforms.

e Fixes a port conflict bug in multi-user environments. The prior release did not work properly when two users
running the Catalyst Client were logged into the same multi-user server with Remote Desktop Services or Citrix.

e Includes new versions of both Catalyst Client and Catalyst Configuration Manager. On systems running Catalyst
1.0.2 or older, the older components must be uninstalled from Add/Remove Programs before installing 1.0.3.

What's new in Catalyst 1.0.2:

e Fixes an issue where desktop shortcuts and URLs accessed from the Run command opened slowly and generated
an error message on PCs running Windows XP where Catalyst had taken over as the default browser from Internet
Explorer. Catalyst properly takes over as the default browser now.

e Fixes an issue where Catalyst did not properly return Internet Explorer as default browser on Windows 7 when
“Clearing Local Settings" in the Catalyst Configuration Manager. Catalyst properly returns Internet Explorer as the
default browser now.

e Improves the user experience for IT admins when adding a custom browser in the Catalyst Configuration
Manager. Prior versions of Catalyst failed to work properly without trailing backslash ("\") at the end of the path
name. Catalyst now automatically inserts a trailing backslash if none is found.

What's new in Catalyst 1.0.1:

e Fixed an issue where the Catalyst Controller failed to start on PCs with only the Catalyst Client but not the Catalyst
Configuration Manager installed. The issue was caused by a missing or unreadable required Registry Key which is
now properly created during first use of the Catalyst Client.

e Fixed an issue requiring browsers referenced in projects to match browsers installed on client PCs. Catalyst now
runs properly on systems with only Chrome and Internet Explorer or only Firefox and Internet Explorer using the
default settings created for new projects in Catalyst Configuration Manager.

e Fixed an issue that caused a crash in Catalyst Configuration Manager under certain conditions when rules were
reordered. Rules can now be reordered reliably.

e Fixed an issue where the Starting Browser appeared to hang while navigating to Internet Explorer while certain
Windows Explorer windows were open.
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